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Glossary of terms 
For the FinPrint project, these terms are defined as follows: 

 

ANNOTATOR: Someone who watches video assignments and adds Observations 

ANNOTATOR APPLICATION: (aka Annotator Client) The FinPrint desktop application used to 

annotate videos. 

ASSIGNMENT: A Set with a Video which gets assigned to someone (usually an Annotator) to 

make Observations 

BRUV:  Acronym for Baited Underwater Remote Video, which is the technology used to attract 

and video record organisms.  A BRUV Drop is synonymous with a Set. 

DROP:  The placement of a BRUV in a specific location on a reef. 

EVENT: The identification of something in a Set video that gets recorded in the database.  Each 

Observation is an Event itself, but can also have multiple Events associated with it (i.e. for 

different behaviours of the same organism.) 

HABITAT:  The coral benthic environment of a reef 

IMAGE NOTES: Image, or Event Notes concerning a particular time. EG “Shark now attacking 

turtle”  

LOCATION:  A geographically generally correlating to a specific country (i.e. Fiji, Bahamas) or 

country area (i.e. US-Pacific, US-Western Atlantic) within a specific Region that contains 

multiple Reefs. 

OBSERVATION: The identification of something in a Set video that gets recorded in the 

database (e.g. Animal species, Object of Interest). An Observation can have different 

attributes/events associated with it besides the species like an image, Behavior or Fouling state. 

OBSERVATION NOTES: Typically, a note about a particular animal, regardless of the time of 

observation. EG “Really big shark” or “Unusual pattern on flank”. Compare with Image notes. 

SET:  A specific occurrence of a BRUV drop. 

TRIP:  A defined journey to a specific Reef, containing multiple BRUV SETs.   

VIDEO:  Digital recording, typically 60-90 minutes, for each BRUV SET.  VIDEOs and SETs have a 

1:1 correlation.  



Getting started using the Annotator 

To start the Annotator, open the Vulcan folder on the computer. If you have used the default 

settings during installation, the path will look something like this: 

 

 

If you have a previous version of the annotator tool on your computer, be sure to uninstall that 

first. You can use the ‘uninstall’ file located in the same folder. 

Double-click on the finprint_annotator.exe file (marked, above) to launch the application.  



Enter your login credentials in the highlighted area.  Note that both the User Name and 

Password are case sensitive. 

 

 

When you first log in you will see a pop-up screen showing your current list of assigned videos. 

You can access this list at any time by going to the ‘File  Assigned Set List’ menu option, or 

using the CTRL+L shortcut key.  

 

 



If your assignment list is empty, please contact your Lead, who will assign you videos to 

annotate. **Leads and Superusers will see a different version of the assignment list pop-up. See 

Page 30 or click HERE to see the assignment list for Leads and Superusers. 

Opening and watching a video 

Double-click on a specific video assignment to open it.  This will open the video, but not begin 

playback.

 

 

Error Loading Video 

If you see the ‘Error Loading Video’ message below, it most likely means the video file for the 

assignment is not in the location specified in the File->Properties (CTRL-P) menu item: 

 



To resolve, this, you can either locate the video file and move it to the location specified in the 

File->Properties setting, or you can change the File->Properties setting to point to the file path 

that the video file is located in.   

 

To do the latter, click on File->Properties and then click on ‘Browse…’. A ‘Select Folder’ window 

will open. Locate the folder where your video is stored using the navigation bar on the left-hand 

side.  

 

 

When you have identified the correct folder, click once on it. It will be added to the ‘Folder’ 

location box. In the example shown below, the video has been uploaded onto the User’s hard 

drive, into the ‘Videos’ folder.  



 

Click on ‘Select Folder’ to proceed. Note that the correct video file location is now displayed in 

the ‘Edit properties’ box. Click on ‘Save’. 

 

You should now be able to open and play the video assignment by double clicking it in the 

‘Assigned Set List’ window (open this with CTRL-L). 

 

 

 

 

 

 



Media Controls 

To begin video playback, use the Media Controls, highlighted below. 

 

 

To start playing the video, click ‘Play’. The highest resolution of video file that will play back 

smoothly is 30 FPS (frames per second). 

 

 

To pause the video at any time during playback, click ‘Pause’. 

 

You can also use the SPACE BAR as a shortcut key for playing and pausing the video. 

Clicking either the ‘15s’ or ‘5s’ rewind buttons will stop playback and rewind the video by the 

selected time. You can click these multiple times, to rewind by values of 5 or 15 seconds each 

time.  



 

Alternatively, you can use CTRL↓ (Control + down arrow) to rewind by 15s and CTRL← 

(Control + left arrow) to rewind by 5s. 

 

You can also move backwards or forwards by one frame at a time, using the ‘Advance/Rewind 

frame’ buttons marked below, or the shortcuts SHIFT→ and SHIFT←. 

 

 

To resume normal playback, click ‘Play’. 

 

Click the ‘1.5x speed’ button to view playback at a rate 1.5 times faster than normal speed.  

 

 

Click the ‘Half-speed’ button to view playback at half the normal speed. 



 

 

After using the 0.5x or 1.5x buttons, click ‘Pause’ then ‘Play’ to resume viewing in normal time, 

or use the SPACE BAR shortcut. 

 

The total duration of the video is shown here. 

 

 

You can adjust the picture quality when the video is paused by clicking on the ‘Contrast menu’ 

button.  Note: You will only see the video quality adjustments applied while the video is paused. 

 

A pop-up menu will appear (see below) 



 

 

Adjust Saturation and Brightness as needed, using the sliders. Click on ‘Contrast equalization‘ to 

turn the function on or off. 

 

 

To exit the Contrast menu, click the same button used to open it: 

 



 

 

To view the video in full-screen mode click the ‘Video fullscreen’ button. 

 

Note that playback will pause when switching between fullscreen mode and back, and you will 

need to click ‘Play’ again to resume viewing. 

You can also use the CTRL-U shortcut key or click on ‘Video fullscreen’  in the View menu to 

enter or exit fullscreen mode. 

 

To exit full-screen mode at any time, press ESC. You can also click again on the ‘Video 

fullscreen’ button on the right of the in-video navigation menu. 

 



 

The in-video navigation menu (above/below) is available in normal or full-screen mode. Note 

that clicking on the video screen will NOT pause or restart playback. You must use the 

navigation controls, or the space bar. 

 

 

You can also manually adjust the time slider to any point in the video.  

 

Drag the slider to your chosen time. Press ‘Play’ to resume playback. 

NOTE:  You can use the video slider to rapidly find the point at which the BRUV has settled on 

the ocean floor in order to capture the MARK ZERO TIME.  Once the MARK ZERO TIME has been 

set, you cannot use the slider to advance the video past the point you’ve watched the video in 

normal playback mode. 

**Leads and SuperUsers can use the time slider to advance to any point in the video. 

Additionally, a further 3x playback speed is available for their use: 

 

 



Annotation controls: Creating Observations 

 
Time Events (MARK ZERO TIME, MARK 90 MIN TIME, and MARK HAUL TIME) 
The first observation you create must be the MARK ZERO TIME.  You can use the video slider to 

advance to the point at which the BRUV has settled on the ocean floor to capture the MARK 

ZERO TIME.   

Click-and-drag to frame the entire video screen with either mouse button, to create a rectangle 

on the screen, which results in a menu appearing (bottom-right, below).    

 

 

Select ‘Create non-animal observation’… 

 



 

…and a pop-up window will appear.  

 

You’ll notice the “Tags:” field is automatically populated with the MARK ZERO TIME tag.  Tags 

are pre-defined by project leads to provide a way to consistently identify specific types of 

observations, events, and behaviors across a project.  Your lead can provide guidelines on what 

additional types of Tags you should be using.  

 



 

If applicable, enter any pertinent Observation  or Image notes, then click ‘Save’ to progress.  

 

 

There are two other time-related observations that your lead may require you to mark for each 

video set – MARK 90 MIN TIME and MARK HAUL TIME.  

The MARK 90 MIN TIME is set at the point in the video where you’ve watched 90 minutes of 

video from the point of the MARK HAUL TIME.   

The MARK HAUL TIME is set at the point in the video when the BRUV is raised up off the ocean 

floor back to the boat. 

To set one of these observations, pause playback  and click-and-drag open a new rectangle and 

select ‘Create non-animal observation’. 

 



The ‘New non-animal observation’ window will pop up. 

 

Type ‘mark’ into the ‘Tags’ box or use the drop-down menu to find the ‘MARK x TIME’ Tags. 

 

Select the relevant Time Event Tag and enter any Observation or Image notes, then click ‘Save’.

 



Annotation controls: Animal Observations 

To record an animal observation, first ‘Pause’ playback. Click-and-drag a frame around the 

animal and the observation menu will appear.  

 

Try to keep the frame around individual animals. In the image below two animals are framed. 

 

 

 



This image is better framed.  

 

Hover over ‘Create animal observation’ and an expanded list will pop up (see above). Hover 

over the relevant category list and the species list will pop up (see below).  

 



Species data lists are populated by ‘Region’ as determined in the ‘Set’ metadata. You can also 

create customized species lists, depending on your needs, via the administration page on the 

website.  

Scroll up or down the list to select the relevant species or type any part of the species name in 

the search box to narrow down the list of species to choose from.  If you are unsure of the 

species, make the observation anyway – you can choose one of the “Unknown…” options or 

make changes to your observations later.  You can also add an Observation or Image note if you 

are unsure if you’ve identified the species correctly.

 



When you have highlighted the species you want to select, double-click it. 

 

The ‘New animal observation’ tab will appear.  

 



MaxN 
You’ll notice just below the Organism name is a field called “MaxN”, which is a very important 

type of observation you’ll need to make for each unique species of shark and ray that you see in 

a specific video.    

 

“MaxN” is short for “maximum number” and each time you see a new maximum number of 

animals of a specific species in the same video frame, you’ll need to record an observation with 

a new “MaxN” value.  So, for example, the first time you see a single Blacktip shark in a given 

video, you’ll want to create an observation for it and specify a value of “1” in the MaxN field.  If 

during the same video, you see two (or more) Blacktip sharks at the same time in the video, 

you’ll want to create a new observation and specify a new MaxN value that indicates how many 

Blacktip sharks you see.  If, later in the video you see more than the previous MaxN value 

Blacktip sharks at the same time, then you create a new observation with the new, greater 

MaxN value.   You’ll notice when you specify a value in the MaxN field, that the MaxN Tag is 

automatically added as well.    

If this is the first appearance of a new animal, you also need to tag it as such. Click in the ‘Tags’ 

field. 



 

Start typing in “first” and you’ll see the ‘Image Frame tags – First appearance of organism’ Tag 

appear (below). 

 



Click ONCE to select the Tag. It will be added just below. 

 

You can add further Tags at this time by following the same process. If you want to remove a 

Tag for any reason, click on it in the field where it is displayed. 

For example, in the observation below both ‘Attracted’ and ‘Passing’ Tags, which are mutually 

exclusive, have been applied. Click once (anywhere) on the Tag you want to remove, in this case 

‘Attracted’. 

 



Note that the ‘Attracted’ tag has been un-applied. 

 

 

Before you save, you can also add any observation or image notes that you feel relevant. You 

can also add a short (8-second) video clip by selecting ‘Capture video’.  

 Your lead can provide guidance on when to include a video clip, but typically you would do so if 

you’re unsure of the species and want to capture the video clip for your lead to see when 

reviewing your observations. This is particularly relevant to low-visibility or low-light situations, 

where the swimming motion/pattern can help identify individual animals.  

 



When you have filled out all the relevant information, click on ‘Save’ to record your 

observation.  

 

Annotation controls: Adding events to existing observations 
In the Annotator, each observation you create is also considered an “event”.  Most 

observations you create will likely be a single event.  But there may be times where you want to 

add additional observation “events” to an existing observation for the same animal.  

For example, you may have observed a shark for several minutes when it swims over the 

camera and you can then determine the sex of the animal – you can then add that data to the 

observation. 

To add an additional observation event to an existing observation, after drawing an extent 

rectangle, hover over ‘Add to existing observation’ from the pop-up menu and then hover over 

the existing observation you want to add an event to and click to select it.  

 



You can also use the arrow keys (up and down) to scroll through existing observations, and 

‘Enter’ to open one. 

The ‘Add event to animal observation’ window will pop up.  

 

 

After making your changes, click ‘Save’. 

 

Observations table 

As you create new observations, you will notice that they appear in normal screen mode (eg 

NOT in full-screen mode) in the Observations table.  You can edit previously-made observations 

from this table without needing to go to the specific location of an observation in the video.   

 



For example, if you make a mistake while setting the ZERO TIME you can delete the observation 

by right-clicking on the observation and selecting ‘Delete -> This entire observation.’  (Note that 

if you delete the MARK ZERO TIME observation, you must then make a new ZERO TIME 

observation to continue making observations.) 

  

 

Double-clicking an observation in any field will open the ‘Edit animal/non-animal observation’ 

control tab (below).  

 

Alternatively, right-click on an observation, in any field, and select ‘Edit’. 



 

Using this menu, you can also ‘Delete’ an observation or specific events within an observation.  

Choosing ‘Delete -> This entire observation’ will delete the observation and all events 

associated with it.  Choosing ‘Delete -> This event within the observation’ will only delete the 

specific event selected (see below). 

 

  

Select ‘Go To Event’ in any observation and the video will be set to the time the observation 

was recorded, and paused. 



 

You can change the organism for animal observations by selecting ‘Change organism’ from the 

menu and navigating to the appropriate organism.   

 



 

Selecting the correct organism will automatically update the observation. 

When you have watched the entire video and completed your observations, click ‘Send for 

Review’, which will be enabled after you ‘MARK HAUL TIME’. Congratulations!

 



Annotator user guide for Leads/SuperUsers 

Leads and SuperUsers will see a different pop-up window after signing in to the Annotator 

application.  

The pop-up screen will show the Assignments filter menu, with details of any/all Assignments 

you have made. 

 

You can access this at any time by using ‘File  Filter Review Sets’, or the shortcut CTRL-F. 

 

 

From the Assignments filter menu, you can narrow your search by Trip, Reef, Set, Annotator, 

Status or Affiliation.  

Use the drop-down menus to fill out any relevant fields. 



 

 

 

 

When you are ready, click ‘Search’ to proceed. 

 

 

 



To clear all search fields and start again, click ‘Reset’.  

 

 

To search across all Assignments made by all Leads, uncheck the ‘Limit to assignments made by 

me’ box. 

 

 

The results of your filtered search are displayed below: 

 

 



Video Playback Controls (Leads) 

 

Leads and SuperUsers will have similar media controls to Annotators, except a ‘3x Playback’ 

button is also enabled. Additionally, these users can use the time slider, or click on any 

observation/event in an Assignment to move directly to that point in the video. 

 

 

To Review an Assignment 

 
Click once on an assignment to highlight it. 

 

 

Double-click to open it.  

 

 

 

 



 

The video will automatically open, but will not begin playback.  

 

 

To Assess/Edit Observation Events 
You can use the Observations table to navigate directly to any given Event. Each Observation is 

listed in reverse chronological order (ie the MARK ZERO TIME observation is listed at the 

bottom). Click once on an Event to highlight it. Right-click to open a pop-up menu. From there, 

click on ‘Go To Event’. 

 



 

The video will automatically be set to the time of the event, but will not begin playback. You 

can right-click on any non-animal event to: Go to the Event; Edit the Event, Delete (the Event), 

or Set Duration. Clicking ‘Cancel’ will exit the pop-up menu. 

 

 

If you select ‘Edit’, a pop-up window will appear (see below).  

 

 



Make any changes needed, and click ‘Update’ to proceed. Click ‘Cancel’ to exit without saving 

any changes. 

 

For Animal Events, a further option to ‘Change the organism’ will be available. This will provide 

a drop-down list of available organisms to choose from (see below).

 

 



When you select the correct Organism, the Event will automatically be updated. You do not 

need to save changes made in this way. 

 

Accepting/Rejecting Assignments 

When you have finished reviewing a video, click on either ‘Accept assignment’ or ‘Reject 

assignment’ to proceed. 

 

 

Updates will automatically be made to the Finprint Global website. 

 

 

 

 

 

 

 

 



Quick-Start Media Controls  

 

 

Menu Shortcuts:  

Keyboard shortcuts are marked in this guide in red. 

CTRL-L = Open assigned set list 

CTRL-P = Edit video folder properties 

CTRL-F (Leads only) = Open assignments filter menu 

CTRL-Q = Quit application 

CTRL-H = Help/Open User Guide 

 

In-video Shortcuts: 

CTRL-U = Enter/Exit Fullscreen mode (when video is loaded) 

SPACE = Play/Pause video 

CTRL-↓ = Rewind 15s 

CTRL-← = Rewind 5s 

SHIFT-→ = Advance one frame 

SHIFT-← = Rewind one frame  



Mouse and on-screen buttons  

Mouse commands and on-screen buttons (eg ‘Save’) are marked in this guide in green. For 

example, ‘Click-and-drag’ a rectangle around the animal… 

 

 

…or click on ‘Send for Review’. 

 

 

 

 



Annotator setup and troubleshooting for Windows 10 

Before opening the Annotator application, ensure the machine is set up for optimal 

performance. This can have a significant effect on performance. 

Close unnecessary applications 
Close any applications including email, productivity applications (Excel, Word, etc.), web 

browser, etc. that may be running - unless necessary for annotation.  Users often have a 

browser or application open to reference a species guide.  This is fine as long as it doesn’t 

appear to affect video playback.  If playback is not smooth, then you may need to close the 

browser/ application in between use, or use a secondary device (i.e. tablet, phone) for the 

species guide. 

Set display resolution 
Set the display resolution between 1920 X 1080 and 1280 X 960 

The optimal resolution for the Annotator is typically 1920 x 1080.  Higher resolutions can cause 

playback issues.  Lower resolutions down to 1280 x 960 are often acceptable, but may result in 

the observation table not fitting on screen in normal view mode (requiring horizontal scrolling).  

Anything less will typically result in text being truncated from controls. 

To set resolution: 

a. Go to the desktop and right-click the mouse 
b. Select ‘Display settings’ 
c. Click on the ‘Advanced display settings’ link towards the bottom of the screen.  
d. Under ‘Resolution’ menu select ‘1920 x 1080’ or, if necessary, a lower resolution at or 

above ‘1280 x 960’ 
Or: 

a. Go to the desktop and right-click the mouse 
b. Select ‘Display settings’ 
c. Select ‘1920 x 1080’ from the ‘Resolution’ drop-down menu 

 

Set Power Saver  
Confirm the Power Saver setting is set to ‘Balanced’ or ‘High Performance’ 

To check current Power Saver settings, click on the ‘Battery’ icon on the right-hand side of the 

toolbar. Power Mode will be displayed. In some versions of Windows you can adjust the ‘Power 

Mode’ slider to ‘High Performance’ from here. Otherwise, click on ‘Power and Sleep Settings’ 

then ‘Advanced Settings’ to view current Power Saver settings. 

 

For Windows 10 machines, you can adjust the Power Saver settings via ONE of the following: 



Computer settings  

a. Click the Windows/Start icon in the lower-left corner of the Windows Task Bar at the 
bottom of the screen 

b. Click the Settings icon (looks like a gear) 
c. Click ‘System’ 
d. Click ‘Power and Sleep’ from the menu on the left 
e. Click the ‘Additional Power Settings’ link 
f. Select either ‘High Performance’ or ‘Balanced’ 

 
Or Control panel 

a. Click the Windows/Start icon in the far-left corner of the Windows Task Bar at the 
bottom of the screen and type “control panel” OR type “control panel” into the Cortana 
input box in the lower left part of the Windows Task Bar. 

b. Click on ‘System and Security’ 
c. Click on ‘Power Options’ 
d. Select either ‘High Performance’ or ‘Balanced’ 

 

Disable antivirus scan 
If antivirus software is actively running a scan of the computer it can have a significant impact 

on its performance and the ability to play videos in the Annotator smoothly.  If the antivirus 

software is currently running a scan, disable it. Open ‘Task Manager’.  Right-click on the 

Windows Task Bar at the bottom of the screen and select ‘Task Manager’ from the pop-up 

menu. (see below.) 

 

 



To expand the Task Manager menu, click ‘More Details’. 

 

 

If your antivirus is running a scan, it should appear at or very near the top of the Task Manager 

list of processes (which should sort by default in order of the processes consuming the most 

CPU power.)   You should see something like the following: 

 



(NOTE:  Depending on the specific antivirus software you have, you may see a variation of this, 

but it should be clear that an antivirus scan is running and consuming a significant amount 

(>10%) of CPU resources.)  

To stop the antivirus software from running a scan, click on the virus scan item in the list and 

then click on the “End task” button in the bottom right corner of the Task Manager.    

 

 

NOTE:  Anti-virus scan software is typically configured to run scans periodically, so stopping a 

scan that’s currently running will not prevent future scheduled scans from running. 

 



Disable the syncing service of applications such as Dropbox, Google Drive, and 
Microsoft OneDrive 
Popular cloud-based file management software such as those listed above will regularly scan 

the computer to see if changes were made to documents stored locally that need to copied to 

the cloud. This synchronization process can affect the computer’s performance and the ability 

to play videos in the Annotator smoothly. Disable this synchronization process temporarily 

while you are using the Annotator tool. Each different type of application will have its own 

unique way for disabling the sync service, but below is an example of how to do so for one of 

the more common cloud file services – Dropbox, as well as links to disabling Google Drive and 

Microsoft OneDrive. When you have finished using the Annotator, you can go back into the 

application settings and re-enable the sync process.  

For Dropbox, for example, the synchronization process can be disabled via the following steps:  

If Dropbox is running on your machine, you should see an application icon in the System Tray in 

the right-hand corner of the Windows Task Bar along the bottom of the computer screen.  Click 

on this icon to pull up a Dropbox menu.  

 

 
 
 
Click on the Settings icon (looks like a gear) in the upper right corner of the menu that appears. 
 



 
 
 
Click on “Pause syncing” from the settings menu that appears 
 

 
 



Once you have finished using the Annotator tool, you can go back into the Dropbox application 

settings in the same manner and select “Resume syncing” to re-enable the syncing process. 

For Google Drive and Microsoft OneDrive, the following links provide instructions on how to 

disable the syncing process: 

Google Drive – follow the steps in “Quit Google Drive” in the following on-line help:  

https://support.google.com/drive/answer/2375081?hl=en 

 
Microsoft OneDrive – follow the steps in “Disable OneDrive in Windows 8.1 and Windows 10” 

in the following on-line help: https://support.office.com/en-US/article/Turn-off-or-uninstall-

OneDrive-f32a17ce-3336-40fe-9c38-6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1 

(NOTE:  For Microsoft OneDrive follow the same instructions but choose “Disabled” in the final 

step, in order to re-enable file syncing.) 

 

For technically advanced users 
Disable other applications/background processes that are consuming a significant amount of 

CPU resources. 

NOTE: if you are not comfortable with making advanced changes, proceed to the section below 

on sending system information to your lead. 

In addition to the troubleshooting steps outlined above, advanced users can review the list of 

applications and background processes running in Task Manager and disable those that are 

consuming a significant amount (> 5-10%) of CPU resources.   

NOTE:  This is recommended for more technically advanced users only.  Caution should be 

taken to not disable any processes that might affect normal computer functioning.   

 

Additional Troubleshooting:  Sending computer info to your Lead 

If you are still experiencing playback issues, you can send two things to your FinPrint Lead that 

will help them troubleshoot the Annotator playback performance further.  This information will 

help them identify whether there are resource limitations on your machine and/or another 

application may be interfering with its ability to play smoothly.  These include a copy of your 

“DxDiag.txt” file and a screen shot of your Task Manager. 

 

 

https://support.google.com/drive/answer/2375081?hl=en#_blank
https://support.office.com/en-US/article/Turn-off-or-uninstall-OneDrive-f32a17ce-3336-40fe-9c38-6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1#_blank
https://support.office.com/en-US/article/Turn-off-or-uninstall-OneDrive-f32a17ce-3336-40fe-9c38-6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1#_blank


Create a “DxDiag.txt” File  
This file can be created using the DirectX Diagnostic Tool that should already exist on your 

computer and will capture your computer’s system information. 

Click the Windows/Start icon in the far-left corner of your Windows Task Bar and type ‘dxdiag’ 

OR type dxdiag’ into the Cortana input box in your Windows Task Bar and select the ‘dxdiag 

(Run Command)’ in the results menu. 

 

 

The DirectX Diagnostic Tool will start and an application screen will launch (see below).  Click on 

the ‘Save All Information’ button at the bottom. 

 



 

 

Save the DxDiag.txt file to a location on your computer (Desktop is default). 

 



Email this DxDiag.txt file to your FinPrint Lead.  They will review your computer’s system profile 

to determine what other next steps can be taken. 

Create a screenshot of Task Manager 
Task Manager will show other applications that could be interfering with the Annotator playing 

smoothly.  Follow these steps to generate a screen shot of your Task Manager and send it to 

your FinPrint Lead. 

Right-click on the Windows Task Bar at the bottom of your screen and select ‘Task Manager’ 

from the pop-up menu. 

 

 

The Task Manager window will appear.  Take a screen shot of your machine by finding and 

pressing the ‘PrtScn’ or ‘PrtSc’ or equivalent key on your keyboard.    

 

 



 

 

After capturing the screen print, paste it into a Microsoft Word (or equivalent word processor) 

document, save the document file on your machine, and email the document to your FinPrint 

Lead as an attachment.  Saving it within a Word document makes it easier to zoom in on and 

read. 

 

 

 

 



Annotator setup and troubleshooting for Windows 8 

Before opening the Annotator application, ensure the machine is set up for optimal 

performance. This can have a significant effect on performance. 

Close unnecessary applications 
Close any applications including email, productivity applications (Excel, Word, etc.), web 
browser, etc. that may be running unless necessary for annotation.  Users often have a browser 
or application open to reference a species guide.  This is fine as long as it doesn’t appear to 
affect video playback.  If playback is not smooth, then you may need to close the browser/ 
application in between use, or use a secondary device (i.e. tablet, phone) for the species guide. 
 

Set display resolution 
Set the display resolution between 1920 X 1080 and 1280 X 960 

The optimal resolution for the Annotator is typically 1920 x 1080.  Higher resolutions can cause 

playback issues.  Lower resolutions down to 1280 x 960 are often acceptable, but may result in 

the observation table not fitting on screen in normal view mode (requiring horizontal scrolling).  

Anything less will typically result in text being truncated from controls. 

To set resolution: 

a. Go to your desktop and right click on your mouse 
b. Select “Screen resolution”  
c. Under the “Resolution” menu select “1920 x 1080” or, if necessary, a lower 

resolution at or above “1280 x 960”.  
 

Set Power Saver  
Confirm the Power Saver setting is set to ‘Balanced’ or ‘High Performance’ 

For Windows 8 machines, you can adjust your Power Saver settings via the following: 

a. Click the Windows/Start icon in the far left corner of your Windows Task Bar at the 
bottom of your screen and type “control panel”. 

b. You should see the Windows search panel open in the upper right corner of your screen.  
Choose the “Control Panel” application that should appear at the top of the list 

 



  

 
c. From the Control Panel screen, click on the “System and Security” text link at the top. 

(NOTE:  This assumes your Control Panel view is by “Category”.  If the view is by “Large 
icons” or “Small icons”, then you should see a “Power Options” icon, which you should 
click on instead) 

d. From the “System and Security” screen, click on the “Power Options” text link.   
e. Select either “Balanced” or click on the down arrow to “Show additional plans” and 

select “High Performance”.  Typically the “Balanced” option is sufficient.  

 

Disable antivirus scan 
Confirm your anti-virus software is not currently running a scan of your computer 

If your antivirus software is actively running a scan of your computer it can have a significant 

impact on its performance and the ability to play videos in the annotator smoothly.  You can 

check if your antivirus software is currently running a scan and, if so, disable the scan by 

following these steps: 

 

1) Open your computer’s “Task Manager” in order to see currently running programs and 
services by doing the following: 

 
a. Right click on the Windows Task Bar at the bottom of your screen and select 

“Task Manager” from the pop-up menu 
 



 

 

b. If your antivirus is running a scan, it should appear at or near the top of the Task 
Manager list of processes.  Click on the “CPU” Column header once or twice to 
ensure it’s sorting the list of items in descending order by CPU% (as indicated by 
small grey down arrow shown below).  If a scan is running you should see 
something like the following (NOTE:  Depending on your specific antivirus 
software you may see a variation of this, but it should be clear that an antivirus 
scan is running and consuming a significant amount (> 10%) of CPU resources.) 
 



 
 

c. To stop your antivirus software from running a scan, you can click on the virus 
scan item in the list and then click on the “End task” button in the bottom right 
corner of the Task Manager.   NOTE:  Anti-virus scan software is typically 
configured to run scans periodically, so stopping a scan that’s currently running 
will not prevent future scheduled scans from running.  
 

 

 



 

Disable the syncing service of applications such as Dropbox, Google Drive, and 
Microsoft OneDrive 
Popular cloud-based file management software such as those listed above will regularly scan 

your computer to see if changes were made to documents stored locally that need to be copied 

up to the cloud.   This synchronization process can affect your computer’s performance and the 

ability to play videos in the annotator smoothly.   You can disable this synchronization process 

temporarily while you are using the annotator tool.   Each different type of application will have 

its own unique way for disabling the sync service, but below is an example of how to do so for 

one of the more common cloud file services – Dropbox, as well as links to disabling Google 

Drive and Microsoft OneDrive.  After you are finished using the annotator, you can go back into 

the application settings and re-enable the sync process.  

 

For Dropbox, for example, the synchronization process can be disabled via the following steps:  

1) If Dropbox is running on your machine, you should see an application icon in the System 
Tray in the right hand corner of the Windows Task Bar along the bottom of your 
computer screen.  Click on this icon to pull up a Dropbox menu.  
 

 
  
 



2) Click on the Settings icon (looks like a gear) in the upper right corner of the menu.   
 

 

 

3) Click on “Pause syncing” from the settings menu that appears as follows: 
 

 



4) Once you are done using the annotator tool, you can go back into the Dropbox 
application settings in the same manner and select “Resume syncing” to re-enable the 
syncing process. 

 

For Google Drive and Microsoft OneDrive, the following links provide instructions on how to 

disable the syncing process: 

 

- Google Drive – follow the steps in “Quit Google Drive” in the following on-line help:  
https://support.google.com/drive/answer/2375081?hl=en 
 

- Microsoft OneDrive – follow the steps in “Disable OneDrive in Windows 8.1 and 
Windows 10” in the following on-line help: https://support.office.com/en-
US/article/Turn-off-or-uninstall-OneDrive-f32a17ce-3336-40fe-9c38-
6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1 
 

NOTE:  For Microsoft OneDrive, you’ll want to follow the same instructions but choose 

“Disabled” in the last step in order to re-enable file syncing.  

 

For technically advanced users 
Disable other applications/background processes that are consuming a significant amount of 

CPU resources. 

NOTE: if you are not comfortable with making advanced changes, proceed to the section below 

on sending system information to your lead. 

Disable other applications/background processes that are consuming a significant amount of 

CPU resources. 

In addition to the above troubleshooting steps, advanced users can review the list of 

applications and background processes running in Task Manager and disable those that are 

consuming a significant amount (> 5-10%) of CPU resources.  NOTE:  This is recommended for 

more technically advanced users only.  Caution should be taken to not disable any processes 

that might affect normal computer functioning.   

 

 

 

https://support.google.com/drive/answer/2375081?hl=en#_blank
https://support.office.com/en-US/article/Turn-off-or-uninstall-OneDrive-f32a17ce-3336-40fe-9c38-6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1#_blank
https://support.office.com/en-US/article/Turn-off-or-uninstall-OneDrive-f32a17ce-3336-40fe-9c38-6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1#_blank
https://support.office.com/en-US/article/Turn-off-or-uninstall-OneDrive-f32a17ce-3336-40fe-9c38-6efb09f944b0?ui=en-US&rs=en-US&ad=US&fromAR=1#_blank


Additional Troubleshooting:  Sending computer info to your Lead 

If you are still experiencing playback issues, you can send two things to your FinPrint Lead that 

will help them troubleshoot the annotator playback performance further.  This information will 

help them identify whether there are resource limitations on your machine and/or another 

application may be interfering with its ability to play smoothly.  These include a copy of your 

“DxDiag.txt” file and a screen shot of your Task Manager.  Simple instructions for creating these 

are below: 

 

1) Creating a “DxDiag.txt” File – this file can be created using the DirectX Diagnostic Tool 
that should already exist on your computer and will capture your computer’s system 
information.  You can create the file following these simple steps: 

a. Click the Windows/Start icon in the far left corner of your Windows Task Bar at 
the bottom of your screen and type “dxdiag”. 

 
 
 

b. You should see the Windows search panel open in the upper right corner of your 
screen.  Choose the “dxdiag.exe” application appearing at the top of the list. 
 

 
 

c. The DirectX Diagnostic Tool will start and you’ll see the following application 
screen.  Click on the “Save All Information” button at the bottom.  



 

 

d. Save the DxDiag.txt file to a location on your computer (desktop is default).   
 

 



 

e. Email this DxDiag.txt file to your FinPrint Lead.  They will review your computer’s 
system profile to determine what other next steps can be taken. 

 

2) Creating a screenshot of your Task Manager.  Your Task Manager will show other 
applications that could be interfering with the annotator playing smoothly.  Follow these 
steps to generate a screen shot of your Task Manager and send it to your FinPrint Lead.   

 

a. Right-click on the Windows Task Bar at the bottom of your screen and select 
“Task Manager” from the pop-up menu as shown below:  

 

 

 

 

b. You should see the following Task Manager window appear.  Click on the “CPU” 
Column header once or twice to ensure it’s sorting the list of items in descending 
order by CPU% (as indicated by small grey down arrow shown below).   
 



 
 

a. Take a screen shot of your machine by finding and pressing the “PrtScn” or 
“PrtSc” or equivalent key on your keyboard.   
 

 
 
 

b. Paste the screenshot into a Microsoft Word (or other word processor) 
document, save the document file on your machine, and email the document to 
your FinPrint Lead as an attachment.  Saving it within a Word document makes it 
easier to zoom in on and read.   


